
          International Research Journal of Engineering and Technology (IRJET)      e-ISSN: 2395-0056 

                Volume: 04 Issue: 09 | Sep -2017                       www.irjet.net                                                               p-ISSN: 2395-0072 

 

© 2017, IRJET       |       Impact Factor value: 5.181       |       ISO 9001:2008 Certified Journal       |        Page 270 
 

Estimation of Dynamic Behavior and Performance Characteristics of a 

Vehicle Suspension System using ADAMS  

A.MD.Zameer Hussain basha1, S.Mahaboob Basha2 

1PG student,department of mechanical engineering,Chiranjeevi Reddy Institute of Engineering and 
Technology,Anantapur,AP-515001 

2Head of the department of mechanical engineering, Chiranjeevi Reddy Institute of Engineering and 
Technology,Anantapur,AP-515001 

---------------------------------------------------------------------***---------------------------------------------------------------------
Abstract - This work proposes a methodology to estimate 
tire side slips angles in front-wheel steered, rear-wheel driven 
four wheeled vehicles.   A three degree-of-freedom model with 
slip angle, yaw rate and roll angle as degrees of freedom was 
constructed to capture the coupling between steering and roll 
dynamics of such vehicles. An open-loop estimator was 
designed based on this model to estimate the side slips angles 
of tires using available real-time measurements which include 
steering angle, steering torque and suspension positions. The 
model incorporates all sources of compliance, stiffness and 
damping, all with non-linear characteristics. The vehicle 
model is created in ADAMS (automatic dynamic analysis of 
mechanical systems) formulation. The model is used for the 
purpose of vehicle handling analysis. The estimator was 
validated by comparing its predictions with that of an ADAMS 
model. The paper presents a comparative analysis between 
different half-car models for the suspension system of the rear 
axle of the motor vehicles, the difference between models 
consisting of how the equilibrium of the car body is assured.  
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1. INTRODUCTION 
 
 1.1 Suspension system: The suspension system of an 
automobile helps to support the car body, engine and 
passengers, and at the same time absorbs shocks received 
from the ground while vehicle moves on rough roads and un 
even roads. The dynamic model of the suspension and 
steering system of the motor vehicles includes the kinematic 
elements - bodies (car body, axle, wheel carrier, guiding 
links), as well as the elastic and damping elements (ex. 
springs, dampers, bushings, antiroll bar, bumper and 
rebound elements) are very important to understand the 
behavior of the vehicle.. The increasingly growing demand 
for more comfortable passenger car imposes new models of 
the guiding systems, close to real systems on the vehicle. 
Suspension systems serve a dual purpose — contributing to 
the vehicle's road holding/handling and braking for good 
active safety and driving pleasure, and keeping vehicle 
occupants comfortable and a ride quality reasonably well 
isolated from road noise, bumps, and vibrations. A typical 
suspension system is shown in the figure 1. 

 

Figure 1: Suspension terminology 

1.2 Steering system 

Steering system is used to control the vehicle directions 
when it is moving on road. Many modern vehicles use rack 
and pinion steering mechanisms, where the steering wheel 
turns the pinion gear; the pinion moves the rack, which is a 
linear gear that meshes with the pinion, i.e. for some rotation 
of steering angle rack moves some distance to produce angle 
to wheels. In simple way it is nothing but converting circular 
motion into linear motion along the transverse axis of the car 
(side to side motion).Figure 2 shows the assembly of 
steering and suspension system. 

 
 

Figure 2: Suspension with steering 
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1.3: Steady-state handling characteristics 

• Steady-state handling performance is concerned 
with the directional behavior of a vehicle during a 
turn under non-time-varying conditions. 

•  An example of a steady-state turn is a vehicle 
negotiating a curve with constant radius at constant 
forward speed. In the analysis of steady-state 
handling behavior, the inertia properties of the 
vehicle are not involved. 

When a vehicle is negotiating a turn at moderate or high, 
speeds, the effect of the centrifugal force acting at the center 
of gravity can no longer be neglected. To balance the 
centrifugal force the tires must develop appropriate 
cornering forces. A side force acting on a tire produces a side 
slip angle. 

Slip angle α 

 Slip angle α is the angle formed between the direction of 
wheel travel and the line of intersection of the wheel plane 
with the road surface. 

Tire cornering (lateral) stiffness Cα 

The cornering stiffness Cα is used to compare the cornering 
behavior of different tires.  

 

Figure 3: Ackerman Steering Geometry 

1.3.1: Neutral Steer 

When the under steer coefficient Kus = 0, which is equivalent 
to the slip angles of the front and rear tires bring equal (i.e., αf 
= αr and wf /Cαf = wr/Cαr), the steer angle δ required to 
negotiate a given curve is independent of forward speed and 
is given by δ = b / R 

 

1.3.2: Under Steer 

When the understeer coefficient Kus > 0, which is equivalent 
to the slip angle of the front tire of being greater than that of 
the rear tire, (i.e., αf > αr and wf /Cαf > wr/Cαr), the steer angle 
required to negotiate a given curve increases with the square 
of vehicle forward speed. 

1.3.3: Over Steer 

When the under steer coefficient Kus which is equivalent to 
the slip angle of the front tire αf being less than that  of the 
rear tire αr (i.e., αf < αr, and wf /Cαf < wr /Cαr), the steer angle 
required to negotiate a given curve  decreases with the 
increase of vehicle forward speed. 

 

Figure 4: Steering effects 

1.4 Suspension Outputs 

There are more than 70 outputs we will get from suspension 
analysis. Basic outputs are described below. 
 
Toe: The difference in distance between the front and rear of 
the tires, when the tires are closer together at the front than 
at the rear, the wheels are said to be toed in, and if they are 
farther apart at the front, they are toed out. Toe-in is also 
called positive and toe-out negative. 
 
Camber: The inward or outward lean of the top of the wheel. 
If the top of the wheel tilts outward from true vertical, it has 
positive camber, and if it tilts inward at the top, it has 
negative camber. 
 
Caster Angle: Forward or rearward tilt of the steering 
knuckle away from true vertical. Viewed from the side, a line 
drawn through the upper and lower ball joints (SLA) 
describes the caster angle.  
 
Steering Axis Inclination (SAI): The angle, away from true 
vertical, formed by a line drawn through the ball joints (or 
the lower ball joint and the upper strut mount on 
MacPherson strut systems). The SAI is always an inward tilt. 
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Slip angle: Understanding tire slip angle is fundamental to 
understanding how to go faster on four wheels.  

Tire slip angle creates a force that is known as “cornering 
force“. It is cornering force that makes a vehicle able to turn 
a corner. The more cornering force you have available the 
less you have to slow down for corners. 

In the case of a racing vehicle, the less you have to slow 
down, the quicker you can do a lap/complete the stage/get 
up the hill etc … 
 
Scrub Radius: The distance between where the SAI line 
meets the road and the centerline of the tire. It is the turning 
pivot area for the tire’s contact patch on the road.  If the 
scrub area is inboard of the centerline, it is said to be a 
positive scrub radius, and if it is outside of the centerline, it 
is said to be a negative scrub radius. 
 

 
Figure 5: Scrub radius 

 
Coordinate system: The below figure shows the 
representation of a vehicle in coordinate system i.e pitch, 
yaw & roll. 
 

 
 

Figure 6: Standard vehicle coordinate system 

2. ABOUT ADAMS 
 
ADAMS is a multi-body dynamics simulation tool developed 
by MSC software. It also called as mechanical system 
simulation tool. The abbreviation of ADAMS is automatic 
dynamic analysis of mechanical systems. In this paper we 
used ADAMS car template to build the suspension system. 
Adams/Car, part of the Adams 2013.1® suite of software, is 
a specialized environment for modeling vehicles. It allows 
you to create virtual prototypes of vehicle subsystems and 
analyze the virtual prototypes much like you would analyze 
the physical prototypes. You create assemblies in Adams/Car 
by defining vehicle subsystems, such as front and rear 
suspensions, steering gears, anti-roll bars, and bodies. You 
base these subsystems on their corresponding standard 
Adams/Car templates. For example, Adams/Car includes 
templates for double-wishbone suspension, MacPherson 
strut suspension, rack-and-pinion steering, and so on. When 
you analyze an assembly, Adams/Car applies the analysis 
inputs that you specify. For example, for a suspension 
analysis you can specify inputs to: 
 

 Move the wheels through bump-rebound travel and 
measure the toe, camber, wheel rate, roll rate, and 
side-view swing arm length. 

  Apply lateral load and aligning torque at the tire 
contact path and measure the toe change and lateral 
deflection of the wheel. 

 Rotate the steering wheel from lock to lock and 
measure the steer angles of the wheels and the 
amount of Ackerman, that is, the difference between 
the left and right wheel-steer angles. 

 
Once you complete the analysis of your model, you can share 
your work with others. You can also print plots of the 
suspension characteristics and vehicle dynamic responses. 
In addition, you can access other users' models without 
overwriting their data. 
 
• Euler-Lagrange method to create equations of motion 
• Predictor-corrector methods to solve equations 
• Integrated animation and plotting 
• Powerful parametric, scripting and post-processing 

abilities 
 
Applications: 

• The general purpose graphical user interface is 
Adams/View 
– Model building, simulation submission, animation 

• Equations are built and integrated with Adams/Solver 
– Solver is a standalone application, but typically used 

seamlessly from within Adams/View 
• Plotting and animation done with 

Adams/PostProcessor 
– Tightly integrated with Adams/View 

• Industry verticals (e.g., Adams/Car) for model 
templates 



          International Research Journal of Engineering and Technology (IRJET)      e-ISSN: 2395-0056 

                Volume: 04 Issue: 09 | Sep -2017                       www.irjet.net                                                               p-ISSN: 2395-0072 

 

© 2017, IRJET       |       Impact Factor value: 5.181       |       ISO 9001:2008 Certified Journal       |        Page 273 
 

3. Multi body simulations of suspension system 
 
It contains how to modify and analyze a double-wishbone 
suspension system. The Adams basic model is taken from 
Adams template builder and analyzed with the multiple 
inputs.  Mainly two types of analysis are considered to check 
the performance characteristics. 
 
1) Quasi static suspension analysis 
2) Dynamic suspension analysis 
 
To perform the analysis, you must first create a double-
wishbone suspension and steering subsystem from standard 
Adams/Car templates and subsystems. Adams/Car 
templates define a subsystem’s topology and specify how 
one subsystem connects to another. Templates also contain 
default parameters, such as locations, part masses, and 
inertias. The following figure 7 shows the Adams template. 
 

 

Figure 7: Double wishbone suspension with steering 
system 

 
3.1 Create suspension model in ADAMS 
 

In this section, work carried with a suspension and 
steering assembly from two subsystems: a suspension 
subsystem and a steering subsystem. You create the 
suspension subsystem using the standard double wishbone 
template. We don’t need to create the steering subsystem. 
Instead, we can open an existing subsystem that provided by 
Adams car template. 

 
To create the front suspension subsystem: 
 
1. Start Adams/Car Standard Interface as described in 
Starting Adams/Car Standard Interface. 
2. From the File menu, point to New, and then select 
Subsystem. 
3. In the Subsystem Name text box, enter UAN_FRT_SUSP. 

4. Set Minor Role to front. A minor role defines the 
subsystem’s function and its placement in the assembly (for 
example, front or rear). In this case, you select front because 
you are creating a front suspension. 
5. Right-click the Template Name text box, point to Search, 
and then select shared_car_database. 
6. Select templates.tbl and double-click _double_ 
wishbone.tpl. 
7. Verify that Translate from default position is not 
selected. 
Adams/Car creates the suspension subsystem using the 
default data contained in the template and displays it as 
shown in figure 8. 
 

 

Figure 8: Double wishbone suspension template 
 
This suspension system has joints, constraints and locations 
of assembly hard points which created according to the 
suspension data in Adams car template. It also contains 
flexible elements like springs and buses to control the 
vibrations. 
 
3.2 Creating suspension assembly 
 
After successfully creating suspension template we have to 
assemble proper steering assembly and test rig to conduct 
different tests on the suspension system. 

1. From the File menu, point to New, and then select 
Suspension Assembly. 

2. In the Assembly Name text box, enter my_assembly. 

3. Click the folder icon next to Suspension Subsystem. 

The name of the suspension subsystem you just created 
appears. 

4. Select Steering Subsystem. 

5. Right-click the Steering Subsystem text box, point to 
Search, and then select the shared_car_database. 

6. Select subsystems.tbl and double-click 
MDI_FRONT_STEERING.sub. The Steering Subsystem text 
box now contains MDI_FRONT_STEERING.sub and an alias to 
its directory path. 

Note that by default Adams/Car selects a test rig for the 
assembly,__MDI_SUSPENSION_TESTRIG. 
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Now preparing the model for test is completed. Figure 9 
shows the assembly of suspension system, steering system 
and test rig. 
 

 

Figure 9: Adams suspension assembly model 
 
3.3 Performing a Baseline Parallel Wheel Travel 
Analysis(Quasi-static analysis) 
 

In this session a parallel wheel travel analysis on the 
suspension and steering assembly need to be perform, then 
plot and view the results. The following steps performed on 
assembly. 

 
• Defining Vehicle Parameters 
• Performing the Analysis 
• Animating the Results 
• Plotting the Results 
 
3.3.1 Defining Vehicle Parameters 
 

Before performing a suspension analysis, you must 
specify several parameters about the vehicle in which you 
intend to use the suspension and steering subsystems. These 
parameters include the vehicle’s wheel base and sprung 
mass, whether or not the suspension is front- or rear-wheel 
drive, and the braking ratio. For this analysis, you enter the 
parameters to indicate front-wheel drive and a brake ratio of 
64% front and 36% rear. To define vehicle parameters: 
From the Simulate menu, point to Suspension Analysis, and 
then select Set Suspension Parameters. The following 
assumptions are considered for this analysis. 
 
 

 All driving force is applied to the front wheels. 
 The brake ratio value indicates the % of braking 

force that is applied to the front brakes. 
 

Figure 10 shows the all considered suspension parameters. 
 
3.3.2 Performing the Analysis 
 

During the analysis, the test rig applies forces or 
displacements, or both, to the assembly, as defined in a load 
case file. For this analysis, Adams/Car generates a temporary 
load case file based on the inputs you specify. 

 
This parallel wheel travel analysis moves the wheel centers 
from -100 mm to +100 mm relative to their input position, 
while holding the steering fixed. During the wheel motion, 
Adams/Car calculates many suspension characteristics, such 
as camber and toe angle, wheel rate, and roll center height. 
 

 

Figure 10: Adams suspension parameters 

 
1. From the Simulate menu, point to Suspension Analysis, 
and then select Parallel Wheel Travel. 

2. Set up the analysis as follows: 

• Suspension Assembly: my_assembly 
• Output Prefix: baseline 
• Number of Steps: 100 
• Mode of Simulation: interactive 
• Bump Travel: 100 
• Rebound Travel: -100 
• Travel Relative To: Wheel Center 
• Steering Input: Angle 

3. Select OK. The following data shows inputs for analysis 
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3.3.3 Animating the Results 
 

In this section, you view the analysis you just ran. 
Adams/Car has already loaded the animation and graphic 
files for animating representation of results. 

 
To animate the results: 
 
1. From the Review menu, select Animation Controls. 
2. Select the Play tool. 
 
Adams/Car animates the motion of the suspension analysis. 
Notice that the suspension moves from rebound (down), to 
bump (up), and that the steering wheel does not rotate. 
 
 The following figure 11 shows the results from baseline 
analysis. It shows the reaction forces and moments. 
 

 

Figure 11: Reaction solution 

3.3.4 Plotting the Results 
 
Adams provides post processor tool where we can compare 
and take the plots for different characteristics of suspension 
system. 
 
The following plots are some of the characteristic plots from 
base line parallel wheel travel analysis. 
 

 
 

Figure 12: Caster angle 

 

 
 

Figure 13: Caster moment arm 
 

 
 

Figure 14: Roll steer 
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Figure 15: Scrub Radius 
 

 
 

Figure 16: Toe Angle 
 
3.4 Dynamic suspension analysis 
 
A Suspension Assembly consisting of a double wishbone 
suspension and a rack and pinion steering system. The 
dynamic suspension analysis is carried out to actuate the 
wheel pads across a range of frequencies. 
 
● To simulate using the Dynamic Solver Statements, go to 

Simulate –> Suspension Analysis –> Dynamic 

● You will use View Functions to define the vertical 
displacement of the Jack. The function below steps up 
the amplitude from 10 mm in bounce and rebound to 30 
mm respectively with a frequency of 4 Hz. 

● Insert step(time,2,10*sin(4*pi*time),8,30*sin 

(4*pi*time)) into both the left and right Vertical Input 

Function fields. Assuming other effects are zero. 

 

Figure 17: Dynamic inputs 
 

3.4.1 Results 
 
Plot the bushing force in the lca_front bushing: 
 
● Hit the F8 key in Adams/Car to switch to 

Adams/PostProcessor 

● Locate the bkl_lca_front_force and bkr_lca_front_force 
REQUEST under user-defined REQUESTs: 

● The fz_front component corresponds to magnitude of 
the force in the Z direction. Plot this quantity to obtain 
a figure18 similar to the one below: 

 

 

Figure 18: force output 

4. CONCLUSIONS 

Quasi-static analysis and dynamic analysis of double 
wish bone suspension system is carried using multi-body 
dynamics simulation software. Various vehicle characteristic 
plots studied and analyzed in static and dynamic behavior 
under 4Hz frequency repose. Since equal amount of 
frequency response is considered in both left and right side 
wheels the response of the system also giving same fore on 
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both sides of the wheels. Hence the suspension model is 
perfect and does not have any disturbances in force sharing. 
The maximum force is observed in static for 100mm bounce 
and re-bound  is 4096N and the moment is 66000N-mm. 
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